IT Essentials: PC Hardware and Software v4.1 Chapter 12 — Lab/Student

12.2.2 Lab: Advanced Installation of Windows XP

Introduction
Print and complete this lab.

In this lab, you will install a Windows XP operating system by using an answer file for automation.
You will customize partition settings and create an administrative user and limited users.

Recommended Equipment

The following equipment is required for this exercise:
e A computer with a new installation of Windows XP
e Windows XP installation media
¢ A blank, formatted floppy disk

Step 1
Log on to the computer.

Insert the Windows XP Professional CD in the CD-ROM drive.
Click Perform additional tasks.

® Welcome to Microsoft Windows XP.

ﬂ Welcome to Microsoft Windows XP

?é What do you want to do?

[®] Install Windows XP

|§| Learn more about the setup process
IEI Install optional Windows components
|§| Perform additional tasks

(] Check system compatibility

(X] Exit
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Step 2
Click Browse this CD.

B Welcome to Microsoft Windows XP

2

' 'y Welcome to Microsoft Windows XP

0 What do you want to do?

(3] Set up Remote Desktop Connection
[>] set up a home or small office network
[3] Iransfer files and settings

[>] Browse this CD

[3] View the release notes

(] Install .NET Framework

€ Back

Double-click the Support folder.

Double-click the Tools folder.

Double-click Deploy.CAB.

Highlight all of the files by clicking Edit > Select All.
Right-click setupmgr.exe and then click Extract.

Click Make New Folder to create a folder on the C: drive.
Name the folder “Deploy”.

Click Extract to extract the files from the CD to C:\Deploy.

Browse to C:\Deploy.
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Step 3
Double-click setupmgr.exe.
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Step 4
The “Setup Manager” window appears.
Click Next.
% Setup Manager, @

Welcome to Setup Manager

Setup Manager helpz you prepare the configuration et and
argwe file bo automate the preinztallation of YWindows on wour
destination computers.

To continue, click Mexst.

Cancel
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The Create new button should be checked by default.

Click Next.

% Setup Manager

Hew or Existing Answer File
A anzwer file tellz Setup how ta install and configure Windows.

An anzwer file iz a zoript that provides answers to the questions or options presented
during *Windows Setup. For example, if vour angwer file provides an answer to the
"Select a time zone" prompt, that page will not be shown to the end uzer dunng Setup.

" Madify existing

< Back | Nest = | Cancel

Click the Unattended setup radio button.

Note that a CD-based answer file name must be Winnt.sif.

% Setup Manager,

Type of Setup

The type of zetup pou chonse determines the name and farmat of the resulting
anawer file.

Thie angwer file pou create will either be Unattend b, Syeprep.int, or a =i file,

Chooze a type of zetup:
& 3

The answer file for Setup iz commonly called Unattend bat, but for a CO-bazed
zetup, the anawer file must be named Winnt sif.

" Sysprep setup

Syzprep.int iz an optional answer file that can be used to automate a getup mode
called Mini-Setup.

" Bemote Installation Services [RIS)

This type of zetup allows the end user to zet up Windows fram a Femate [nstallation
Server. Setup Manager creates 5 sif file.

< Back | Hest » | Cancel
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Click the Windows XP Professional radio button, and then click Next.

¥ Setup Managar

Product
Which Windows product will be ingtalled uging thiz anawer file’?

Select a'windows product;

" Windows %P Home Edition

 Windows <P Professional

" windows Server 2003, Standard E dition
" windows Server 2003, Enterprize E dition
" Windows Server 2003, Web Edition

< Back | Mext » | Cancel

Click the Fully automated radio button, and then click Next.

¥ Setup Manager

Uszer Interaction
Select the type of uzer interaction pou want,

" User controlled

“'ou provide default optionz in the angwer file, and the end uzer can change any of
them.

You provide all required answers in the answer file, and the end uszer iz not
prompted for them.

" Hidden pages
You provide angwers for zetup pages that are hidden from the end uzer.

" Bead anly

You provide all required answers in the answer file. The end user can see the
optionzs but cannat change them.

™ GUI athended

Only the text-mode portion of Setup iz automated. The GUI portion of Setup runz
normally, prompting the end uzer at each page.

¢ Back | Mest » | Cancel
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Click the Set up from a CD radio button, and then click Next.

% Setup Manager

Distribution Share

The diztribution zhare containz the OPK toolz, the \Windows files, and pour
configuration sets.

Setup Manager can create a diztribution share on your computer or network with the
required "Windows source files. You can then add files ta further cuztomize your
inztallations. For example, you can supply additional device drivers.

What would pou like bo do?

(" Create a new distibution share

" Modify an existing distribution share

< Back | Mest » | Cancel

Click the | accept the terms of the License Agreement checkbox, and then click Next.

¥ Setup Manager

License Agreement
Do you accept the terms of the License Agreement for Windows™?

rou chose to fully autormate the inztallation of Windows. To uze this option, you must
accept the terms of the End User Licenze Agreement [EULA] and any Microzaft license
agreements pou have far the verzion of Windows you want to install.

For more infarmation about the EUILA, consult your documentation or your Microsoft
icenze agreement.

To continue with Setup Manager, select the following check box, and then click Mest.

v | accept the terms of the License Aareemment

< Back | Mest = | Cancel
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Click Name and Organization in the list on the left.

Type the name and the organization name provided by your instructor.

Click Next.

% Setup Manager

File Help

—I- General Settings
Mame and Organization
Dizplay Settings
Time Zone
Froduct Key

=1 Metwork Settings
Computer Mames
Administrator Password
Metworking Components
Workgroup or Domain

= Advanced Settings
Telephory
Regional Settings
Languages
Browser and Shell Settings
Installation Faolder
Inztall Printers
Fun Once
Additional Commands

Hame and Organization
“'ou can customize Windows Setup by providing a default name and organization.

Type the default name and organization you want to use. If pou leave these boxes
blank., the name and arganization will not be specified in the answer file, and the end
uzer will be prompted to enter the information during Windows Setup.

Mame: |BOb

Organizatior: |CiSCD

On the left side of thiz page, the steps of Setup Manager are shown for your information.
The highlighted step iz your curent position. Y'ou can mowve to any step in Setup
Manager by clicking that step in the list.

Cancel

| Mext » |

Click Time Zone in the list on the left.

Click the time zone for your location from the “Time zone:” drop-down box, and then click

Next.

¥ Setup Manager E'E'@

Fil=  Help

=1 General Settings
Mame and Organization
Diizplay Settings
Time Zoke
Product Key

=1 Metwork Settings
Computer Mames
Administrator Password
Metworking Components
‘wiorkgroup or Domain

= Advanced Settings
Telephory
Regional Settings
Languages
Browser and Shell Settings
Installation Folder
Install Printers
Run Once
Additional Commands

Time Zone
‘windows will be set up with the time zone setting you specify.
Select a time zone for the destination computers.

If you do not select a specific time 2one zetting, the following default time 2one iz uzed:
[GMT -02:00) Pacific Time [(US & Canada): Tiuana

Time zone:

< Back | MNest » I Cancel
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Highlight Product Key in the list on the left.

Type the Windows XP Professional product key supplied by your instructor in the
“Product Key:” fields.

Click Next.

] Setup Manager

File Help
=] General Settings Product Key
Mame and Organization The Product Key identifies your copy of \wWindows.
Display Settings
Time Zone Type a Product Kep for the destination computers. You need a separate license for
Product Key each copy of 'Windows you install

-1 Network Settings The Praduct Key you specify must match the Product Key provided to vou by Microsoft

Computer Names Licensing. Inc.. as it appears on the certificate of authenticity [COA) label on the
Administrator Password destination computer.
Metworking Components
Workgroup o Domain

=] dvanced Setlings
Telephony
Regional Settings
Languages
Browser and Shell Settings
Installation Folder
Install Printers
Run Once
Additional Commands

Product Kay:
[12245 —|67930 —|2BCDE —|FGHM  —|KLMNO

< Back e Cancel

Click Computer Names in the list on the left.

Type the computer name provided by your instructor in the “Computer name:” field, and
then click Add.

The computer name will then display in the “Computers to be installed:” field.

Click Next.

E® Setup Manager

File Help
=1- General Settings Computer Hames
Mame and Orgarization Each computer on a netwark must have a unique identifier.
Display Settings
Time Zane Type a name for each destination computer [15 characters maxkimum), and then click
Product Key Add.

=1~ Metwork Settings
Computer Names
Administratar Password Carmputer name:
Metworking Components Computer]
Warkgraup or Damain

=1 Advanced Settings Computers to be installed:
Telephony
Fegional Settings
Languages
Browser and Shell Settings
Installation Folder
Install Printers

To import computer names from a text file [one computer name per ling). click Import.

Impart....

|

[7 Automatically generate computer names based on the organization name specified
Run Once on the Mame and Organization page
Additional Commands

¢ Back Next > Cancel
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Click Administrative Password in the list on the left.

Type your first initial of your first name and your complete last name in the “Password:”

and “Confirm password:” fields. (For example, jsmith)

Click Next.

& Setup Manager

File Help

=1 General Settings

Dizplay Settings
Time Zone
Product Key

—I- Metwork Settings
Computer Mames

=1 iidvanced Settings
Telephony
Fiegional 5ettings
Languages

Mame and Orgarization

Administrator Passwond
Metworking Components
Workgroup or Domain

Browszer and Shell Settings
Installation Folder
Inztall Printers

Administrator Password
*r'ou can specify a pagsword for the Administrator account on all destination computers.

If you keep a record of the password you choose, help desk technicians or network
administrators can change settings when needed.

l.-h

* Use the following Administrator pazsword [127 characters masimum;
caze-zengitive]:

]

Passward:

xxxxxxx>1

Lonfirm pazsward:

I™ Encrypt the Administrator pagsword in the answer file

[ When a destination computer starts, automatically log on as Administratar

=

Run Once
Additional Commands

< Back | Mest » | Cancel

Click Workgroup or Domain in the list on the left.

Click the Workgroup radio button.

Type the Workgroup name LabGroup1 in the “Workgroup:” field, and then click Next.

# Setup Manager

File Help

—I- General Settingz Workgroup or Domain
Mame and Orgarization

Dizplay Settings

Product Key

The destination computers may belong to either a warkgroup or a damain.

Time Zone Haow will the destination computers participate in a network?

—|- Metwork Settings + ‘wiorkgroup: |LabGloup1

Computer Mames
Administrator Passward £ Domain: |
Metworking Components r
Workgroup or Domain

—I- Advanced Settings

Telephony
Regional Settings |

Languages |
Braowser and Shell Settings

Installation Folder |
Install Printers

Additional C d
gl -emmands after Windows Setup.

Fiun Once If pou specify a domain but don't set up a user account, the end user will be prompted
for & walid uger name and pazsword the first time the computer logs on to the domain

< Back | Mewt > | Cancel
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Click Additional Commands in the list on the left, and then click Finish.

Y Setup Manager f'-_l |E|fg|
File Help
—I- General Settingz Additional Commands
Mame and Orgarization *'ou can add commands that will autamatically run at the end of unattended Setup.
Diizplay Settings
Time Zone *r'ou can run any command that does nok require you to be logged on. Type the
Product Key command in the box below, and then click Add.

—I- Metwork Settings
Computer Mames
Admiriztrator Password &d
Metwarking Components
Wharkgraup ar Darnain

—I- Advanced Settings
Telephony
Regional Settings
Languages
Browser and Shell Settings
Inztallation Folder

Inztall Printers To zpecify commands ta run the first time an end user logs on, use the Run Once page
Run Once of Setup Manager.

Lommand to add:

Fiun these commands:

Lt

Additional Cammands

< Back Cancel |

Type “C:\Deploy\unattend.txt” in the “Path and file name:” field if it is not already
displayed.

Click OK.

™ Setup Manager [z|

Setup Manager has created an answer file with the settings vou provided. To zave the
file, enter a path and file name.

Fath and file name:

Browsze...

[f rultiple: computer names were specified, Setup Manager alzo created a .udhb file.
Depending upon the twpe of anzwer file created, Setup Manager might alzo have
created a sample bat script.

| 2k | Cancel
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Click File > Exit.

73 Setup Manager E'E'@

File Help

created the following files:

C:ADeplophunattend bt

C:ADeploytunattend bat

batch soript.

Completing Setup Manager

‘t'ou have successfully completed Setup Manager and

For information about uging the answer file, view the sample

I—l e

Step 5
Browse to “C:\Deploy”.

Right-click unattend.txt, and then click copy.

Browse to “A:\".

Click File > Paste.

Right-click unattend.txt, and then click rename.

Type Winnt.sif as the new file name, and press Enter.
Copy unattend.bat to the floppy disk.

Remove the floppy disk from the floppy drive.

Click Start > Turn Off Computer.

Click Restart.

© 2007-2010, Cisco Systems, Inc. All rights reserved.
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Step 6
When the “Press Any Key to Boot from CD” message appears, press any key on the
keyboard. Insert the floppy disk. The system will inspect the hardware configuration.

Setup is inspecting your computer’'s harduware configuration...
P P LI P g

The Windows XP Setup screen appears while the program loads the necessary files.
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Step 7
The Welcome to Setup screen appears. Press Enter.

Windows XP FProf ional Se

WHelcome to Setup.

This po
Window
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Fun
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omputer.

Microsoft (R
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pre
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allation uwsing
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To gquit Setup without installing Windows XP,

ENTER=Continue R=Repair F3I=Quit

The “Windows XP Licensing Agreement” screen appears.

Press F8.

Windows XF Licensing Agreement

Microsoft<r> Windows<{(r>? XP Professional
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Windows XP Professional Setup will search to determine if another operating system

already exists on the hard drive.

Windows HP Professional Setup

Searching for previous versions of Microsoft UWindows...

Press ESC.

Windows RP Professional Setup
If one of the following Windows XP installations is damaged.
Setup can try to repair it.
Use the UP and DOWN ARROM keys to select an installation.

= To repair the selected Windows P installation,
press Ro

To continue installing a fresh copy of Windows XP
without repairing, press ESC.

SUWINDOUWS “"Microsoft Windows HEP Professional'

F3=Quit R=Repair ESC=Don’t Repair
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Press the D key.

Windows HP Professional Setup

The following list szhows the existing partitions and
unpartitioned space on this computer.

Use the UP and DOWN ARROM keysz to select an item in the list.
set up Windows XP on the selected item. press ENTER.
create a partition in the unpartitioned space, press G.

delete the selected partition, press D.

Disk B at Id @ on bus B on atapi [MBR]

:  Partitionl [NTFS] 163?% ng ¢ 15787 MB freed

Unpartitioned space

ENTER=Install D=Delete Partition F3I=Quit

Press Enter.

Windows HP Professzional Setup

The partition you tried to delete iz a system partition.

Sysztem partitions may contain diagnostic or hardware configuration
programs,. programs to start operating systems (such as Windows XP).
or other manufacturer—-supplied programs.

Delete a system partition only if you are sure that it contains
no zuch programs or if you are willing to losze them. Deleting a
system partition may prevent your computer from starting from
the hard disk wntil you complete installation of Windows HP.

& To delete this partition. press ENTER.
Setup will prompt you for confirmation hefore
deleting the partition.

= To go back to the previous screen without
deleting the partition,. press ESC.

ENTER=Continue ESC=Cancel
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Press the L key.

Windows XP Professional Setup

You asked Setup to delete the partition
GC: Partitionl [NIFS] 16371 MB ¢ 15787 HB free
on 16377 MB Dizk B at Id B on bus B on atapi [MBRI.
To delete this partition, press L.
CAUTION: All data on this partition will be lost.

To return to the previous screen without
deleting the partition. presszs ESC.

L=Delete ESC=Cancel

Press the C key.

Windows XFP Professi

The following list shows the existing partitions and
wnpartitioned space on this computer.

Use the UF and DOWN ARROW keys to select an item in the list.

To set up Windows XP on the selected item. press ENTER.

To create a partition in the wnpartitioned space, press G,

To delete the selected partition. press D.

ME Disk B at Id @ on bus A on atapi [MBR]

Unpartitioned space 16379 MB

ENTER=Install C=Create Partition F3=Quit
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Type 5000 in the “Create partition of size (in MB):” field.

Press the Enter key.

Windows HP Professional Setup

You asked Setup to create a new partition on
2 MB Disk B at Id B on bus @ on atapi [MBRI1.

To create the new partition. enter a size below and
prezs ENTER.

To go back to the previous screen without creating
the partition, press ESC.

The minimum size for the new partition is 8 megabytes (MB)>.

The maximum size for the new partition is 11374 megabytez (MB).
Create partition of size {(in MB>:

ENTER=Create ESC=Cancel

Press the down arrow key to select “Unpatrtitioned space”.
Press the C key.
Create another partition of 5000 MB.

Repeat this process one more time. You will have three partitions of 5000 MB each.

Windows XP Professional Setup

The following list shows the existing partitionz and
unpartitioned space on this computer.

Use the UP and DOWN ARROW keys to select an item in the list.
= To set up Windows P on the selected item. press ENTER.
= To create a partition in the uwnpartitioned space, press C.

= To delete the selected partition, press D.

16377 MB Disk @ at Id @ on bus @ on atapi [MBRI]

GC: Partitionl [Mew (Rau>]l 4997 MB ¢ 4996 MB freel
Unpartitioned space 11382 MB

ENTER=In=tall C=Create Partition F3=Quit
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Select C: Partition1 and press the Enter key.

Windows XP Professional Setup
The following list shows the existing partitions and
wnpartitioned space on thiz computer.
Use the UP and DOWN ARROW keys to select an item in the list.

To zet up Windows HF on the selected item. press ENTER.

To create a partition in the unpartitioned space,. press C.

To delete the selected partition, press D.

ME Di=k B8 at Id 8 on bus B on atapi [MBR]

: Partitionl [New <Raw>] 4997 MBE ¢ 4996 MB free>
Partition2 [Mew ¢Raw>] 4997 MBE ¢ 4996 MB free>
F: Partition3d [Mew (Raw>] 4297 MB ¢ 49?6 MB freel

Unpartitioned space 1381 HMB
Unpartitioned space & HMB

ENTER=Install D=Delete Partition FI=Quit

Select “Format the partition using the NTFS file system”.

Do not select ““Format the partition using the NTFS file system <Quick>".

Press the Enter key.

Windows XP Professional Setup

A new partition for Windows HF haz been ereated on
1k ? HBE Dizk B at Id 8 on buz B on atapi [MBRI.
Thiz partition must now be formatted.

the [ % £ i tem For the r partition.

the UP L L k to ect the File tem you want.

and then p

the partitio 1 the HWIFS

Format the partition us
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The “Please wait while Setup formats the partition” screen appears.

Windows XP Professional Setup

Please wait while Setup formats the partition
Partitionl [New (¢ ' 4887 MB < 4886 MB free)

on 4895 MB Disk 8 at Id 8 on bus 8 on atapi [MBRI].

Setup is formatting...

The system will restart automatically.

After the system restarts, the message “Press Any Key to Boot from CD” appears.
Do not press any keys.

The installation should continue without prompting you for any settings.

The system will restart automatically.

After the system restarts, the message “Press Any Key to Boot from CD” appears.

Do not press any keys.
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Step 8
The “Welcome to Microsoft Windows” screen appears.

Click Next.

To continue,

Click the Help protect my PC by turning on Automatic Updates now radio button.

Click Next.

puter and install them

'\‘2 okﬂelp protect my PC by turning on Automatic Updates now

{recommended)

<7 # Not right now
[ turned on Automatic Updat rcomputer is more vulnerable to v i Dther security

identify you or contact you.
2ht.

© 2007-2010, Cisco Systems, Inc. All rights reserved.
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Click the Yes, this computer will connect through the local area network or home
network radio button.

Click Next.

0 g Microsoft :
*z Windows

Will this computer connect to the Internet
directly, or through a network?

u finish

Click the No, not at this time radio button, and then click Next.

B g Microsoft :
#» Windows

Ready to register with Microsoft?

our information
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Type the name provided by your instructor in the “Your name:” field.

Click Next.

indows

Who will use this computer?

Start menu,

The “Thank you!” screen appears.

Click Finish.

dows

Thank you!

useful infatmation in the Help and
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Step 9
The “Windows XP Professional” desktop appears.

Click Start > Control Panel.

——r

| i Bob
4 Internet u My Documents
Inkernet Explorer
> B My Recent Documents
f 3] E-mail

Qutlook Express @ My Pictures
\' MSH @ My Music
gi My Computer
Wwindows Media Playver

E—’ contral Panel
_-‘% Wwindows Messenger

@ Set Program Access and
Defaults

@ Tour Windows ¥P Q Printers and Faxes

Files and Settings Transfer
wizard y @) tielp and Support

p Search

77 Run...

All Programs D

FF |§| Turn Off

Step 10
Click User Accounts.

B Control Panel

File Edit View Favorites Tools  Help #
Qe - @ - F| Psearch [[Z Folders | [T~
address | [ Control Panel hd Go

H’ Control Panel & Pick F | category

B Swicch to Classic Yiew

\ & Appearance and Themes Printers and Other Hardware

See Also ) =

b Windows Update

1)
(7)) Help and Suppork 1w

User Accounts

Network and Internet Connections

Options

"
e
? Add or Remove Programs 2 Date, Time, Language, and Regional

i ) f:/) Sounds, Speech, and Audio Devices Accessibility Options

_' Performance and Maintenance Security Center
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Click Create a new account from the “Pick a task...” list.

Learn About

|__'a Uset accounts
@ User account bypes

[2] Swicching users Pick a task...
Change an account
Change th

L)

or pick an account to change

Bob

Guest
Computer: administrator Gues!

Type the name provided by your instructor in the “Type a name for the new account:”
field.
Click Next.

=% User Accounis

= eBack @ nHome

Name the new account

Type a name far the new account:
[5amantha ]

Assign the account name that you chose and then proceed
to the next account creation step.
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Click the Limited radio button.

Click Create Account.

Pick an account type

() Computer administrator @J}Imlttﬁd

twiith a limited account, you can:
# (Change or remove your password
# Change your picture, theme, and other deskbop settings
® Yiew files you created
# Wigw Files in the Shared Documnents Folder

Users with limited accounts cannot always install programs, Depending on the program, & user
might need administrator privileges to install it

Also, programs designed pfar to windows 5P or Windows 2000 might not work propetly with
limited accounts. For best résults, choose programs bearing the Designed For Windows XP loga,
or, ko run older programs, choose the "computer administrator” account bype,

[ < Eack] [ create Account | [Cancel ]

Learn About . » User Accounts

@ User accounts
@ User accournt bypes

[2] swicching users Pick a task...
Change

or pick an a?:count to change

Bob Samantha
Cormputer administrator

Create a second limited user. Your instructor will provide the name of the user.
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What was the name of the file used to automate the installation located on the floppy
disk?

How do you think automating the installation will help the IT Department if they have to
repeat the procedure on 100 computers?
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